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1 
About this Writer’s Guide 

This Managed Objects Writer’s Guide is intended for use and reference by 
Managed Objects technical writers who develop, format, review, or edit technical 
documents.  

This chapter contains the following topics: 

Introduction 
Template 
Page Setup 
Language Used 
Documentation Archive 
Checking Out Documents for Editing 
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Introduction 
This Writer’s Guide documents the formatting and language requirements for 
Managed Objects technical documentation. All technical documents produced 
use this Writer’s Guide to ensure consistency and ease of use throughout the 
Managed Objects technical documentation. The following sections describe the 
chapters contained in this guide. 

Template 
This Writer’s Guide describes the template used to format Managed Objects 
technical documents. Managed Objects documents use a Word template that 
contains the styles used throughout the documentation. The template contains 
the styles that are used to automatically format all document contents. 

Using Styles 
Styles that are retained in the template contain the exact format requirements for 
each type of content used in documents. Chapter 2 lists all styles and their 
format characteristics. 

Template Naming Convention and Versioning 
Each time a change is made to the template, a new version is saved. The 
template file name is: MO Template VX.X where X.X indicates the template 
version. 

Page Setup 
The template does not establish the overall page setup requirements that control 
the margins. Instructions for using Word’s Page Setup feature are included in this 
Writer’s Guide. See Page Setup Requirements. 

Language Used 
The use of a consistent vocabulary and language style helps users understand 
the application and consistently execute the procedures. This Writer’s Guide 
establishes the language style used for technical documents. See Technical 
Writing Requirements. 

Documentation Archive 
Managed Objects technical documentation archive is retained at: 

Filebank\Development\Product Documentation 

Templates for technical documentation are retained at: 

Filebank\Development\Product Documentation\DOCS - Templates 

Screen snaps and original diagrams are also retained in the archive.  

Graphic Files 
When possible, graphic files comply with the following guidelines: 

§ Use the GIF file format for graphics. 
§ Graphics are named to describe dialog or topic to which they relate.  
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§ Graphics are saved in folders that indicate the document or product in which 
they are used. 

Checking Out Documents for Editing 
Before editing a user guide, it is important to check out the latest copy from the 
trunk or the associated branch in Subversion. Normally, the trunk is used for the 
next major release; however some changes may need to be made on a branch 
for a patch or minor release. Determine if a tag is necessary when checking out 
files from Subversion. A branch is specified using a tag when the file is updated.  

For more information about Subversion, see http://lurch.mosol.com/twiki/bin/view. 
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2 
Using the Template 

This chapter describes the Managed Objects template, defines the styles used to 
format all content, and provides instructions for applying the template styles to 
content and attaching the template to documents. 

This chapter contains the following topics: 

Template Styles 
Attaching a Template to a Document 
Maintaining Styles in a Document 
Correcting Errors in MS Word 
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Template Styles 
All content in a document is assigned a style stored in the template. The 
following table lists all styles available, the format characteristics of each style, 
and the content to which the style is applied. 

Managed Object Template Styles 
Style Format Characteristics Content Type 
Body Text Arial 10pt., Space Before 6 pts., Space After 6 

pts. 
Paragraphs use style Body Text. To bold 
words within a paragraph, use the Bold icon. 
No separate style is used for Bold Body Text. 

Callout Arial Bold 9 pt. Apply to text or other characters that are 
outside paragraphs. Callouts are frequently 
used to point to sections of a graphic. Right 
justify callouts as needed on the left side of 
graphics. 

Chapter List Arial 10 pt., Bold, Underlined, Color – Indigo, 
Space After 6 pt. 

After the introduction to each chapter, a list of 
all Heading 2 subjects is listed using the Word 
Hyperlink – Bookmark feature. Apply the 
Chapter List style to the hyperlink bookmarks.  

Chapter Number Arial 48 pt., Shadow, Centered in 1”X1” table 
with Blue/Gray shading and border with 
dashed line 2 ¼ pts. 

At the top of each chapter page, the number of 
the chapter is inserted in a text box. Use 
Chapter Number to format the number. 

Code Courier New 10 pt., top, bottom, left, right 
borders Single Line, Gray 50%, Border 
Spacing 1 pt. 

Use Code to format computer code that users 
enter or that displays on a user interface.  

Copyright Content Arial 9 pt. Standard copyright text is listed after the cover 
page of each Managed Object document. Use 
Copyright Content for paragraphs. 

Copyright Heading Arial 9 pt. Bold Certain headings within the standard copyright 
information presented in Managed Objects 
documents are listed. Use Copyright Headings 
for the standard headings used to separate the 
copyright information. 

CP – Doc Title Arial Narrow 36 pt., Bold, Color – Indigo, Flush 
Right, Space Before – 12 pt., Border – Top: 
Dashed (small gap), Border Spacing 1 pt 

Use CP Doc Title to format the document title 
on cover page. This style includes a dashed 
line that displays above the title. If the 
document title requires more than one line, do 
not use the enter key to move part of it to a 
new line because this will cause the dashed 
line to repeat. Press <Ctrl Enter> to move part 
of the title to a new line. 

CP – URL Arial Narrow, Color – Gray 50%, Flush Right Use the CP – URL style for the Managed 
Objects web address on the cover page. 

CP – Version Arial 14 pt., Color – Gray 40%  Use the CP – Version style for the version 
number that displays on the cover page. Use 
spaces to separate the Formula logo from the 
version number so that the version number is 
right justified. 

Footer Body Text with Bold and Italics, Color – Indigo, 
Flush Right, Space Before 6 pt. 

Text in the footer that displays automatically 
using the Word Field Insert feature is 
formatted using the Footer style. 

Gutter Text Arial 9 pt., Color – Indigo, Border Top and 
Bottom – Dotted, Light Blue, ¾ pt. Lind Width, 
Border Spacing 1 pt. 

Gutter Text is used to format text in text boxes 
that display in the left margin. Gutter Text is 
used to emphasize brief points throughout the 
documents. 
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Managed Object Template Styles 
Style Format Characteristics Content Type 
Heading 1 Arial Narrow 24 pt., Bold, Shadow, Flush 

Right, Line Spacing 1.5 Lines, Space Before 6 
pt., Space After 90 pt., Keep with Next, Level 
1, Tabs: 1” 

Heading 1 is used for the title of each chapter.  

Heading 2 Arial Narrow 18 pt., Bold, Color – Indigo, 
Space Before 12 pt., Space After 6 pt., Keep 
with Next, Level 2 

Heading 2 is used for the major sections within 
each chapter. Each Heading 2 is also listed as 
a hyperlink – bookmark in the Chapter List 
section on the first page of each chapter. 

Heading 3 Arial 12 pt., Bold, Italics, Color – Indigo, Space 
Before 12 pt., Space After 6 pt., Keep with 
Next, Level 3 
 

Heading 3 is generally the lowest level used 
within a chapter. 

Heading 4 Arial 10 pt., Bold, Color – Indigo, Space Before 
12, Space After 6 pt. 

Heading 4 is available for use if needed. It is 
the lowest level available. 

Hyperlink Arial 10 pt., Underline, Color – Blue Use the Hyperlink style to identify hyperlinks. 
Words that end in .com are automatically 
formatted as hyperlinks. 

Illustration Arial 10 pt., Space After 6 pt. All graphics that can display between the left 
and right margins use the Illustration style. 

Illustration Caption Arial Narrow 9 pt., Italics All graphics are followed by a caption. The 
caption always begins with the title of the 
graphic, which is bolded. A sentence can 
follow the title, but is not bolded. 

Illustration Left 
Indent 

Arial Narrow 9 pt., Italics, Left Margin –1” Graphics that are too large to display between 
the left and right margins use the Illustration 
Left Indent style, which moves them to the left 
one inch. If the graphic is still too large, 
manually move the graphic farther left. 

Index 1 Arial 10 pt., Indent Hanging .2” Index 1 is automatically assigned to the 
higher-level index entries. 

Index 2 Arial 10 pt., Indent Left Hanging .15”, Tabs 
2.25”, right flush 

Index 2 is automatically assigned to the lower- 
level index entries. 

List Bullet Based on Body Text - Arial 10 pt., Indent 
Hanging .25 “, Space Before 3 pt., Space After 
3 pt., Bullets, Keep Lines Together, Bullet No. 
167Tabs .25” 

The List Bullet style is used to present a list 
within a paragraph. 

List Bullet Indent Based on Body Text - Arial 10 pt., Indent Left 
.25”, Keep Lines Together, Space Before 3pt., 
Space After 3 pt., Bullet No. 167, Tabs .5 

For indented lists within a list, use the List 
Bullet Indent style. 

List Bullet Single 
Step 

Based on Body Text - Arial 10 pt., Indent 
Hanging .25”, Space Before 3pt., Space After 
3 pt., Bullets, Keep Lines Together, Tabs .25” 

Use the List Bullet Single Step for bullet lists 
within step-by-step procedures or when there 
is only one step in a procedure. 

List Number Ariel 10 pt., Indent Left .5”, Hanging .25”, 
Numbered, Keep Lines Together, Tabs .75” 

List Number is used to number step-by-step 
instructions. Set each list to begin numbering 
at 1. 

List Title Veranda 10 pt., Bold, Color – Indigo To begin a step-by-step procedure, use the 
List Title style. 

Note Arial 10 pt., Color – Indigo, Top and Bottom 
Border – Dotted Line, Color – Indigo, ¾ pt. 
Line Width, Border Spacing 1 pt. 

The Note style is assigned to information with 
a paragraph to emphasize it. The information 
is too long to use the Gutter Text style that is 
used for text boxes in the left margin. 
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Managed Object Template Styles 
Style Format Characteristics Content Type 
Page Number Arial 10 pt., Bold, Color – White, Shading - 

Blue/Gray, Border – Single Solid Line, 
Blue/Gray, 4 ½ pt. Line Width 

Page numbers in the footer are assigned the 
page number style. Start with page number 1 
on the first page of Chapter 1. The Table of 
Contents does not have a footer and thus does 
not have page numbers. 

Table Heading Verdana 10pt., Bold, Space Before 2 pt., 
Space After 2 pt., Keep with Next 

The column headings within a table use the 
Table Header style. 

Table List Bullet Arial 9 pt., Indent Hanging .2”, Space Before 3 
pt., Space After 3 pt., Bullets, Tabs .25” 

Bullet lists within a table use the Table List 
Bullet style. 

Table List Number Arial 9 pt., Indent Hanging .25, Numbered, 
Tabs .25 

Numbered lists within a table use the Table 
List Number style. 

Table Text Arial 9 pt., Space Before 2 pt., Space After 2pt. Text within a table uses the Table Text style. 
Table Text Bold Arial 9 pt., Bold, Space Before 2 pt., Space 

After 2pt. 
To bold text within a table, use the Table Text 
Bold style. 

Table Title Verdana 10 pt., Bold, Space Before 0 pt., 
Space After 0 pt., Keep with Next 

All tables are assigned a title that uses the 
Table Title style. 

TOC 1 Arial 11 pt., Bold, Color – Dark Blue, Indent -
.5:, Hanging .5”, Space Before 6 pt., Space 
After 6pt., Numbered, Tabs .25”, Right Flush 

TOC 1 is used to list all Heading 1 topics in the 
TOC. It automatically numbers each chapter. 

TOC 2 Arial 10 pt., Tabs 5”, Right Flush TOC 2 is used to list all Heading 2 topics in the 
TOC. 

TOC 3 Arial 10 pt., Italics, Indent Left .33” TOC 3 is used to list all Heading 3 topics in the 
TOC. 

TOC Title Arial Narrow 15 pt., Bold, Color – Gray 40%, 
Space After 6 pt. 

The TOC Title style is used for the TOC 
heading and the Index heading. 

Attaching a Template to a Document 
Word stores document templates using the .dot extension. Each time you update 
the styles in a document template, the styles and associated formatting in 
attached documents are automatically updated when you open the documents. 

To attach a document to a template: 

1. Open the document that needs to be attached to a template. 

2. From the Main Menu, select Tools and Templates and Add-Ins. The 
Templates and Add-Ins dialog opens. 

3. Click the Attach button. The Attach Template dialog opens and lists the 
templates available. 

4. Select the template you want to attach and click the Open button. The 
Attach Template dialog closes. 

5. Click to select the Automatically update document styles check box to 
update the styles each time the document opens. 

6. Click the OK button. The document is attached to the template. 

Maintaining Styles in a Document 
When a document attached to a template is edited, new styles can be 
inadvertently created. Text that is pasted into a document often contains styles 
that are not in the template or different formatting parameters for styles. In each 
of these cases, Microsoft Word automatically creates a new style. These styles 
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are not added to the template. However, these created styles display in the Style 
drop-down list in addition to the styles from the template. When new styles are 
inadvertently introduced, you must reassign a style from the template. 

To prevent new styles from being created: 

1. To prevent new styles from being created you can use one of the following 
techniques: 

î Convert text from other documents to the Normal style before pasting it 
in 

î Attach the document that contains the text you want to paste in to the 
template and reassign the appropriate style. 

2. Before finalizing a document, remove any new styles created to ensure that 
subsequent user do not inadvertently use them. 

To remove an automatically created style from a document: 

1. From the menu, click Format and select Style. The Style dialog opens. 

 
2. In the Styles section, click to select the automatically created style you want 

to delete. The style you select displays in the Paragraph preview and 
Character preview sections. 

3. Click the Delete button. The style is removed from the Style drop-down list. 
Text in the document that uses the style is re-assigned the Normal style. 

To remove automatically created styles using the Organizer: 

1. From the menu, click Format and select Style. The Style dialog opens. 

2. Click the Organizer… button. The Organizer dialog opens. 
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3. Click to select the style you want to delete. Use the Ctrl key to select more 

than one style 

4. Click the Delete button. The style(s) are removed from the Style drop-down 
list. 

Correcting Errors in MS Word 
To correct errors in a Word document: 

1. In Microsoft Word, click File and select Open. The Open dialog displays.  
2. Navigate to and click to select the corrupt document. 
3. Click the arrow on the right side of the Open button and select Open and 

Repair. The document opens in MS Word and the Show Repairs dialog 
opens.  

4. Use the Repairs list to review the necessary repairs: 

î Click to select the repair and click the Go To button. The content is 
highlighted in the document. 

î Examine any repairs directly associated with the error message received 
for the document. 

î If a table has errors, examine the Table End-of-Cell Marker 
items. These indicate which tables need to be fixed. Delete the extra row 
in the table. 

5. Save the document. 

6. Reopen the document to verify all errors are resolved. 
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3 
Page Setup 

This chapter defines the page setup requirements for Managed Objects technical 
documents.  

This chapter contains the following topics: 

Page Setup Requirements 
Breaks Between Chapters 
Chapter Numbers 
Appendices 
Page Footers 
Table of Contents 
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Page Setup Requirements 
Page setup includes establishing document margins and selecting layout options. 
It is imperative to properly set up a document’s pages to ensure that the styles in 
the template can be properly applied. 

Margins 
Margins are set at .75” for the top, bottom, right, and left sides of each page. A 
two-inch gutter is set for the left margin. The Header and Footer margins are set 
at .5”. The graphic below shows the proper settings for a Managed Objects 
technical document. 

 
Word Page Setup Dialog – Margins Tab 

Layout 
The Layout tab is used to establish special formatting for pages. Managed 
Objects documents do not require unique formatting for any pages. The graphic 
below shows the proper settings for the Layout tab. 
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Word Page Setup Dialog Layout Tab 

Breaks Between Chapters 
Managed Objects use a consistent set of page and section breaks for technical 
documents. Section breaks are used only when the footer changes from one 
section to another.  

§ Insert page breaks after the: 
§ Cover page 
§ First page of each chapter 
§ Last page of each chapter 

§ Insert section breaks (Next Page) after the: 
§ TOC page – This section break is required because the cover page, 

copyright page, and TOC page do not have a footer. The first page of the 
first chapter, which occurs immediately after the TOC page, begins the 
use of a footer. 

§ Last chapter of each document just before the Index – This section break 
is required because the Index is not a numbered chapter and the first 
half of the footer that refers to chapter number must be removed from the 
footer. 

Inserting Page and Section Breaks 
When you insert a page or section break at the end of a chapter a single line is 
inserted at the top of the next page with the same style as the last line on the 
previous page. Microsoft Word automatically inserts this line. If you were using a 
style that has special formatting such a bullet or a numbered list, a bullet or 
number displays on the first line of the page immediately following the next page. 
To eliminate the special formatting, change the style of the inserted line to Body 
Text. If you delete the line, the style of the last line of previous page is updated 
with the style used. The only way to prevent this is to place the cursor on the very 
first line of the next page prior to creating the page or section break. If there is 
not subsequent page, you must use the Enter key to create enough lines to 
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automatically create a new. For Managed Objects technical documents, insert 
the page or section break without adding enough lines to create a new page and 
update the line inserted to Body Text. 

Chapter Numbers 
Number chapters sequentially. The first page of each chapter displays the 
chapter number in the top right corner in a formatted table. Recording the chapter 
number in the formatted table allows the automated footer to use the chapter 
number in the footer.  

Record the chapter number at the top of the first page of each chapter as follows: 

1. Insert a table with one row and one column. 

2. Resize the table to 1-inch width and height. 

3. Insert a border around the table using a dashed line with 2 ¼ point weight. 

4. Format the background using blue-gray shading. 

5. Enter the chapter number in the table using the Chapter Number style. 

Appendices 
Appendices are identified using alphabetic characters beginning with A followed 
by an hyphen. 

Page Footers 
The page footers contain the chapter title and the page number. All pages are 
numbered sequentially beginning with Chapter 1 page 1. 

The chapter title is inserted automatically using the Word Insert Field feature. 

To insert the Chapter Title in the footer: 

1. Open the page footer on the first page of Chapter 1. 

2. From the Main Menu, select Insert and Field. The Field dialog opens. 

3. In the Categories pane, select Links and Ref. 
4. In the Field pane, select StyleRef. 
5. Click the Options button. The Field Options dialog opens. 

6. Select Chapter Number and click the Add to Field button. 

7. Enter a space, hyphen, and a space. 

8. Select Heading 1 and click the Add to Field button.  

9. Click the OK button. The Field Options dialog closes. 

10. Click the OK button. The chapter number and chapter title automatically 
display in the page footer separated by a hyphen. 

The Index Footer 
The Index does not use the entire footer used in the body of the document 
because it is not given a chapter number. 

To modify the footer for the Index: 

1. Insert a section break after the last line of text in the last chapter of the 
document. A new page is inserted. 
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2. Generate the Index. 

3. From the Menu, click View and select Headers and Footers. The headers 
and footers on the page display. 

4. Delete the word “Chapter” and the spaces and hyphen.  

Table of Contents 
The table of contents is formatted when it is generated. The chapters are 
automatically numbered. Generally, the table of contents presents two levels that 
show Headings 1 and 2. The Index displays as a numbered chapter in the Table 
of Contents because Heading 1 is formatted as a numbered list. To remove the 
numbering from the Index, use the Backspace key. 
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4 
Technical Writing Requirements 

This chapter documents the language, style, and terminology recommended for 
Managed Objects technical documents. 

This chapter contains the following topics: 

General Writing Requirements 
Standard Vocabulary and Use of Terms 
Glossary 
Capitalization Conventions 
Notes and Gutter Notes 
References to Sections, Documents, and Files 
Bulleted Lists 
Tables 
Illustrations and Captions 
Code Samples 
Step-by-Step Instructions 
Using Variables in Step-by-Step Instructions 
Instructing Users to Perform an Action 
Navigation Text for Step-by-Step Instructions 
Standard Terms for Step-by-step Instructions 
Buttons and Icons 
Referring to Screen and Dialog Components 
Miscellaneous Items in Step-by-step Instructions 
Dialog Components 
Formula Browser Components 
Wizards 
Index 
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General Writing Requirements 
The following general writing requirements are defined to optimize the clarity of 
technical documents: 

§ Use the present tense. Do not use will, could, should, or would.  
§ Incorrect: The dialog will open. 
§ Correct: The dialog opens. 

§ Use the active voice. The active voice requires that you identify the subject of 
each sentence. 
§ Incorrect: Account privileges are assigned. 
§ Correct: The System Administrator assigns account privileges. 

§ Minimize the use of “you”. Do not use “you” in step-by-step instructions 
unless there is no other way to phrase it. The work “you” can be used in 
introductory text to explain the role of a user.  
§ Incorrect: You click the OK button to save the file. 
§ Correct: Click the OK button to save the file. 
§ Correct: The Save button allows you to save the file. 

§ Use one space, not two, after a sentence and a colon. 

Standard Vocabulary and Use of Terms 
The following table lists commonly misused words, words for which there are 
more than one way to spell or punctuate the words, and identifies the standard 
established for Managed Objects technical documents. 

Vocabulary and Use of Terms Standards 
Term Standardization of Term 
Automatically / 
Dynamically 

Use dynamically to describe the on-going update of the result of 
an action. Generally used to describe how Views update. 

Log in / Log off Verb form - Log in to Formula. 
Login / Logoff Noun form - Go to the login prompt. Use the Logoff command. 
Menubar / Menu 
Bar 

Use menu bar as two words. 

Open / Display Use open to refer to when a dialog or web page appears. 
Use display to refer to when a tab or view appears. 

PortalBuilder /  
Portal Builder 

Use one word to refer to the PortalBuilder. 

Set Up Verb form - Set up the servers 
Setup  Noun form - Use the UNIX environment setup described below. 
Statusbar / 
Status Bar 

Use status bar as two words. 

Taskbar /  
Task Bar 

Use task bar as two words. 

Titlebar / Title 
Bar 

Use title bar as two words. 

Toolbar / Tool 
Bar 

Use toolbar as one word. 

Tooltip / Tool Tip Use tooltip as a single word. 
Type / Enter When instructing the user to input text, use type. Type the 

following command. 
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Vocabulary and Use of Terms Standards 
Term Standardization of Term 
View Builder / 
ViewBuilder 

Use View Builder as a two words to refer to the feature. 

Web Capitalize the word Web when used as a single word - Web 
browser, Web, Web site 
Do not capitalize the word Web when used as part of another 
word: webmaster 

References to Products and Product Features 
With version 4.0 of our software, the product name was changed from Formula to 
Managed Objects v4. This table outlines the various terms that have been used 
with guidelines for updating them for new terminology. 

Product Terminology 
Was… Now use… 
Formula Delete the reference if possible. To refer to the main 

product, use Managed Objects software 
Formula server server or Managed Objects server 
Formula browser browser or Managed Objects browser 
Organizations If reference is general term (an element under the 

Service Models hierarchy) use element. If reference 
refers to the root element for the Service Models 
hierarchy, use Service Models. (TBD) 

Formula Home Page Managed Objects server Login page 
FormulaScript  
Formula-to-Formula Adapter, 
F2F Adapter 

For formal references, use Managed Objects 
InterCommunication Adapter (ICA). For general 
references in other guides, use InterCommunication 
Adapter (ICA). 

References to Managed Objects 
The company name is Managed Object Solutions. We commonly refer to the 
company as Managed Objects. This is also correct. Please note when Object 
has an s at the end and doesn’t. If you want to refer to the solutions that 
Managed Objects offers, use Managed Objects’ solutions. 

Glossary 
Managed Objects maintains a single glossary that contains terms used 
throughout all technical documentation. The glossary is incorporated into the 
Primer. Terms are also defined within technical documents the first time they are 
used. 

Capitalization Conventions 
The following capitalization conventions are used throughout Managed Objects 
technical documents. 

§ Acronyms - Terms that have acronyms are spelled out the first time they are 
used in a document with the acronym following in parentheses. For example: 
Business Experience Manager (BEM). Subsequent uses of the term use the 
acronym. 
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§ Retain title case capitalization for the following terms, even when they appear 
in the middle of sentences as regular nouns: 
§ Service Level Agreement 
§ Operational Level Agreement 

§ Use title case for capitalization of all headings, table titles, and the names of 
dialogs or pages in captions. Apply superscript to any trademarks or 
registered symbols. 

§ Terms that refer to a specific user interface component are not capitalized. 
The following terms are presented using lower case: 
§ administrator 
§ adapter 
§ agreement 
§ calendar 
§ daemon 
§ health grade 
§ maintenance period 
§ monitor (as in BEM monitor) 
§ objective 
§ schedule 
§ service (as in Windows service) 
§ service level metrics 

§ Capitalize all severity codes 

Bolding Conventions 
Use bold to draw attention to any item in general content. For example, use bold 
for a specific item the user might see or set in the product or in a management 
system such as severity codes or flags or parameters. Examples of when bold is 
used include: 

§ Alarms created by DSM-level objects have a severity of UNKNOWN 
regardless of the criticality of the event being reported. 

§ All attributes in the SpectroServer tagged with the logged attribute 
are recorded over time.  

When referring generically to an item, do not use bold. For example, when 
referring to adapters in general as opposed to a specific adapter, do not use 
bold. In the Adapter guide, do not bold the names of management systems and 
adapters in general content to prevent too much bold text from distracting the 
reader. 

Use bold for the names of user interface components (e.g. dialogs, text box 
labels, check box labels, filenames, file directories) in step-by-step instructions 
and general content with the following exceptions: 

§ Bold the names of views in step-by-step instructions, but not in general 
content unless you need to draw the reader’s attention to them. 

§ Do not bold Explorer pane in step-by-step instructions or general content. 

See Standard Terms for Step-by-step Instructions and Buttons and Icons for 
specific information about each user interface component. 
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Notes and Gutter Notes 
Notes and Gutter Notes are used to highlight information. Both styles use top and 
bottom borders and the Managed Objects logo to draw attention to the 
information. Notes are inserted within a paragraph and Gutter Notes are inside 
text boxes in the left gutter.  

Use Gutter Notes to highlight brief information that is limited to two or three 
sentences. Gutter Notes include information that augments the information in the 
content of the document. Things like Gutter Notes generally include information 
such as tips, warnings, references, and definitions. Gutter Notes do not begin 
with a bolded lead in except if announcing something urgent or if information is a 
tip or warning. When Gutter Notes contain a tip or warning, begin with Tip: or 
Warning:. 
Definitions in Gutter Notes are defined in full sentences with the word being 
defined in bold text. Words are defined within the document at the first 
occurrence of the word and are not repeated. 

 
Use Notes to highlight information within the main text of a document that is 
longer than two or three sentences. Notes are placed inside a table with two 
columns and one row. The Managed Object logo is inserted in the first 
column. 

References to Sections, Documents, and Files 
References Within the Same Document 
When referring to another section within the same document, use the term “See” 
and use a hyperlink to insert the title of the section. For example: 

See Step-by-Step Instructions. 

References to Other Documents 
When referring to a Managed Objects Guide or other document: 

§ Cite the reference beginning with the most general or highest level, 
progressing to the most specific. For example, when referring to a Managed 
Objects guide, cite the guide, chapter, and section. 

§ Separate the components; such as a guide, chapter, and section; with a 
comma. 

§ Separate a chapter and its name with a colon. 
§ When referring to another Managed Objects technical document, use the 

term “Refer” and italicize the entire reference. For example:  
§ For more information, refer to the Administrator’s Configuration Guide. 
§ For more information, refer to the Administrator’s Configuration Guide, 

Chapter 5: Building Business Service Views, Adding Elements.  

References to Files and Directories 
When referring to a file and the directory structure in which it is located, 
combines the directory structure and the file name in one string. Do not separate 
the directory structure and the file name. 

§ Correct: The formula\webapps\download\customCodeSetup.jsp file. 

  
 boxes, which can be
 positioned in the left
 gutter. Gutter Notes
 are placed with the
 same spacing from
 the body text. About
 2/10th of an inch (two
 marks) so that the
 blue dotted boundary
 lines line up on the
 right.
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§ Incorrect: The customCodeSetup.jsp file in the 
formula\webapps\download\ directory. 

Bulleted Lists 
Lists are an effective way of displaying information that cannot be efficiently 
expressed in a sentence and to separate lists of items. Readers can often quickly 
scan a list to survey the points mentioned without having to read every word.  
The following example illustrates a bulleted list. 

Use the Bulleted List style within a paragraph to: 

§ Preview topics 
§ Summary of reasons 
§ Assumptions 
§ Findings 
§ Secondary steps in a procedure 
§ Recommendations 
§ Conclusions 

Tables 
Tables are used to present information that cannot easily be presented in 
paragraphs. Tables can describe menu options, feature options, or the 
components of a user interface. Tables are always right justified against the right 
margin. Tables can remain justified within the left page margin as shown in the 
first table below or they can be extended into the left gutter margin to 
accommodate the information as shown in the second table below. If a table 
exceeds the left margin, manually adjust the table title to the standard left margin.  

The following example of a table identifies the styles used. 

Table Title 
Table Heading Table Heading 
Table Text Bbreak across 
pages.old 

Use the Table Text style for information. 

 

Table Title 
Table Heading Table Heading 
Table Text Bbreak across pages.old Use the Table Text style for information. 

The following format rules apply to all tables: 

§ Assign all tables a title. Insert the table title into a single cell above the first 
row without borders or shading. For  tables that exceed the left margin, 
manually align the table title with the left margin. 

§ Repeat the Table Title and the Table Heading so that they both display 
when a table spans more than one page. 

§ Do not break a long table into multiple tables.  
§ Do not allow cells to break across pages. 
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Illustrations and Captions 
Illustrations include any kind of graphic inserted in the document such as screen 
snaps of product interfaces, architecture diagrams, process diagrams, and 
charts. Use the Illustration style for illustrations that can be contained within the 
margins Use the Illustration Left Indent style to move a graphic one-inch to the 
left. If the graphic continues to exceed the right margin, manually move the 
graphic left. 

If possible, try to restrain illustrations to the left and right margins. If the 
illustration needs to be smaller in width, align to the left margin. This is especially 
important for illustrations within step-by-step instructions. 

For screen shots captured: 

§ Use text boxes with the Callout style to label and illustrations. Use the left 
and right sides of illustration for callouts and only use top when necessary. 

§ Use the GIF file format. GIF files affect document size the least. Save a copy 
to the Documentation Archive. 

§ Use Windows Classic on your desktop setup. 
§ Save a copy in the file archive in corresponding release folder. 
§ Do not place a border around an illustration. 
§ Assign each illustration a caption using the Illustration Caption style. Begin 

the caption with the title of the graphic in bold. Add additional information 
after the illustration title and a colon in text that is not bolded. 

§ Do not use captions on illustrations included as part of a step-by-step 
instruction. 

 
Users Element: The Users element in the Administration tree lets you create and managed users.  In the 
Summary View for this element, you can see the list of existing user. 



Chapter 4 - Technical Writing Requirements  22  

Code Samples 
As we have several developers’ guides and need to communicate code to our 
users, it is necessary that we provide an easy visual way of displaying actual 
code.   

One or two lines of code can be presented using only Courier New text without 
background shading. 

However, when there is a large amount of code you wish to display in the 
document, use the following style: 

Code that is one line can be presented with gray shading. 
Use Courier New, 10pt font with a 15% gray background/50% 
gray border. This format allows the code stands out and 
contains the code to facilitate seeing where it begins and 
ends. 

Manually move the left margin for the code text to present the code text so that it 
is easy to read and understand as shown below. 

Code that is one line can be presented with gray shading. Use Courier 
New, 10pt font with a 15% gray background/50% gray border. This format 
allows the code stands out and contains the code to facilitate seeing 
where it begins and ends. 

Step-by-Step Instructions 
Use step-by-steps to instruct a user how to perform a task. The following 
example shows the formatting of step-by-step instructions. 

To write step-by-step procedures: 

1. Provide a title for the instructions using the List Title style. 

2. Use the List Number style for the steps. 

3. Restart the numbering for each list to 1. 

4. Do not use “or” for alternative ways of performing a step. Introduce 
alternatives using the List Bullet Single Step style with text such as, “To save 
a file perform one of the following steps:” 

î Click the Save button. 

î Click the F2 key. 

5. Avoid the word “you” in instructions. 

6. Identify the result of each step except for when an action updates a view. 
Use the following terms to describe the results listed: 
î A dialog “opens”. 

î A Web page “opens”. 

î A tab “displays”. 

î A button “activates”. 

7. State the ending result of completing each set of step-by-step instructions. 
The ending result is usually related to the purpose of the set of step-by-step 
instructions.  

8. Refer to the series of screens that display in a wizard as dialogs. 
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9. Always use a menu option/properties dialog as the primary method to 
accomplish a task and refer to the Portal view as an alternative.  

10. Use an embedded table instead of bullets to describe the various selections 
for an option. 

11. Do not use numbered callouts on illustrations instead of numbered steps. 

12. Use Shift+Enter to insert a new line immediately after a line that continues 
the style without adding a new paragraph. This is used to insert a line 
between numbered steps and bullets without inserting a new number or 
bullet. For example: 
This line was added by pressing Shift+Enter. 

Using Variables in Step-by-Step Instructions 
A variable is data provided that is specific to a installation, user, or procedure. 
The following table provides examples of variables. 

Examples of Variables 
Variable Type Example 
Installation Installation drive and directories 
User User name and password 
Application File name 

Following are the format requirements for variables: 

§ Bold and italicize variables. 
§ Describe the variable in a list or table. 
§ If using a table to list variables, use the headings “Replace…” and “With…”. 
§ Do not use brackets to identify a variable. 

The following steps provide examples of how to format variables in step-by-step 
instructions: 

1. Type your User Id and password. 

Replace… With… 
User Id Your user name 
Password Your password 

2. Type ;drive:\mos\bin at the end of the Variable Value declaration. 
Replace drive with the installation drive. 

Describing Features Using Toggling Options 
A toggling option refers to the capability to turn on and off various features. 
Toggling options are usually available from menu options, toolbar buttons, or icon 
buttons. This section provides a set of examples of step-by-step instructions for 
toggling options for menus, toolbars, and icons. In addition, this section provides 
examples for instructions that are one of a series of steps (embedded) or when 
the toggling option is a single step.  

 Note: The embedded step-by-step examples present the action followed by the 
result. For example, “From the Format menu, click to select Follow Condition 
Changes to automatically track changes in Element state.” In some cases, 
where there are many features presented in the same step-by-step, it may be 
necessary to invert this format and start with the result before the action. For 
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example, “To dynamically track condition changes, from the Format menu, click 
to select Follow Condition Changes.” 

Toggling from a Menu Option 
Toggling options available on a menu place a check mark beside the option label 
when selected.  When deselected, the check mark disappears. Use “click to 
select or deselect” to describe the action for toggling options available on menus. 

Examples of Toggling Options Available on Menus 
Example of Embedded Step Example of Stand Alone Step 

1. In the Explorer pane, right-click 
the background and click to 
select or deselect Show non-
source element indicators. 
When selected,  indicators 
display beside elements that 
does not contribute to the state 
of their parents. 

To display or hide non-source 
element indicators: 

î In the Explorer pane, right-
click the background and click 
to select or deselect Show 
non-source element 
indicators. When selected,  
indicators display beside 
elements that does not 
contribute to the state of their 
parents. 

1. From the Format menu, click to 
select or deselect Reverse 
Alarm History Sort to sort 
alarms in chronological, 
descending order. Alarm sort 
order persists across client 
sessions and is unique for each 
user. 

To reverse alarm sort order: 

î From the Format menu, click 
to select or deselect Reverse 
Alarm History Sort. Alarms 
sort in chronological, 
descending order. Alarm sort 
order is persistent across 
client sessions and is unique 
for each user. 

Toggling using Toolbar Buttons 
Toolbar toggle options are usually implemented with a button that is compressed 
when selected.  However, in some instances, the button graphic is not the same 
for each setting. For example, a Pause button shows on the Alarms toolbar when 
alarms are active.  When alarms are paused, the button changes to show a 
Resume button. 

Examples of Toggling Options Available as Toolbar Buttons 
Example of Embedded Step Example of Stand Alone Step 

1. In the Filter section of the 
toolbar, click to select or deselect 
the Filter button(s) to remove the 
associated alarms from the view. 
The selected Filter button(s) dim. 

To filter alarms based on 
condition: 

î In the Filter section of the 
toolbar, click to select or 
deselect the Filter button(s). 
The selected Filter button(s) 
dim and associated alarms 
are removed from the view. 
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Examples of Toggling Options Available as Toolbar Buttons 
Example of Embedded Step Example of Stand Alone Step 

1. On the toolbar, click the  
Resume button to resume the 
receipt of alarms. 

To resume alarms: 

î On the toolbar, click the  
Resume button to resume the 
receipt of alarms. 

Toggling from an Icon Button 
Icons buttons, referred to as mini-buttons in development, have gray borders with 
a small icon in the middle. They are often used inside of dialogs or panels (e.g. 
Alarm Filter panel). 

Examples of Toggling Options Available as Icon Buttons 
Example of Embedded Step Example of Stand Alone Step 

1. Click  Show/Hide BSA Off 
Times to display or hide a black 
grid identifying times when BSLM 
data collection is disabled. 

To display or hide the times when 
BSLM data collection is disabled: 

î Click  Show/Hide BSA Off 
Times. When selected, a 
black grid displays in the 
calendar that identifies times 
when BSLM data collection is 
disabled. 

Instructing Users to Perform an Action 
When there are multiple ways to perform an action, do not list all the ways to 
perform the action. Provide the user the most direct way. For example, if the 
action can be performed using the element right-dick menu, the portal view, and 
the Properties dialog, instruct the user to perform the action using the right-click 
menu. If a direct right-click menu is not available, instruct the user to use the 
Properties dialog. 

Using the Portal View 
Generally, using the Portal view is not recommended. The Portal view is most 
useful to the Administrator when they need access to multiple features with one 
click. Because of this, there will be a new section in the Administrator Guide that 
speaks how the Admin may leverage the Portal view when globally setting up 
things. 

Navigation Text for Step-by-Step Instructions 
Frequently, users make a series of selection to navigate to a specific dialog or 
page. To present navigation instructions in the most concise and clear way: 

§ Always state the location from which the navigation begins. 
§ When navigating within the Explorer pane, identify the first selection as an 

element or root element and list the subsequent series of elements selected 
without referring to them as elements. 
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Examples of Navigation Text 
To navigate to a specific element: 

1. In the Explorer pane, double-click to expand the Administration root 
element, Security and Users.  

2. Right-click Users and select Properties. The Properties dialog opens. 

To navigate to a general element: 

1. In the Explorer pane, double-click to expand the Administration root 
element, Security and Users.  

3. Right-click the element and select Properties. The Properties dialog opens. 

4. Click the Automation tab. The Automation tab displays.  

To navigate using the Portal view: 

1. In the Explorer pane, click to select the Administration element.   

5. Click the Portal tab. The Portal view displays. 

6. Scroll to the ACTIONS section. 

7. Click to expand the ACTIONS section. 

Standard Terms for Step-by-step Instructions  
Vocabulary and Terminology for Step-by-Step Instructions 

Component or 
Location 

Terminology/Examples 

Panes The Explorer pane is the only pane referenced in Managed Objects technical documentation. It is 
a term that developed out of the need to refer to the pane in which the hierarchy displays.  
Do not bold Explorer pane in step-by-step instructions or general content. 
Use the preposition “In” when referring to the Explorer pane. 
In the Explorer pane, click to select Administration. 

Tabs Use “displays” when describing the result of opening a tab. 
Bold the names of tabs. 
Click the Portal tab. The Portal view displays. 

 
Click the Automation tab. The Automation tab displays. 
 
Use the preposition “In” when referring to a tab. 
The element condition displays in the Properties tab. 

Dialog-box Refer to a dialog-box as a dialog. 
Dialogs include confirmation windows and information windows. Refer to them as dialogs and 
apply the terms and conventions for dialogs to them. 
Bold the name of dialogs. 
Use “opens” when describing the result of launching a dialog, window, or message/info box.   
Use the preposition “In” when referring to a dialog. 
Right-click Administration and select Properties. The Properties dialog opens. 

Views Use “updates” to describe the changes of a view.  It is not necessary to document that the view 
updates after basic navigation instructions. 
Bold the names of view in step-by-step instructions. Bold the names of view in general content 
only when you need to draw the reader’s attention to them. 
In the Explorer pane, click to select Administration. The view updates.  
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Vocabulary and Terminology for Step-by-Step Instructions 

Component or 
Location 

Terminology/Examples 

Main Menu Use “From” when directing a user from the main menu. Use “select” when referring to the last 
option and “click” for any steps in between.  
Bold the names of menus. 
From the File menu, select Change Password. 
From the View menu, click Default View and select Auto-select. 

Right-click Menus Use “Right-click” to instruct the user to access any menu off of an element, chart, or background. 
Bold the names of right-click menus. 

 
Right-click Administration and select Properties. The Properties dialog opens. 
Right-click the view background and select Properties. The Properties dialog opens. 

Toolbar Use the preposition “On” when referring to a toolbar. 
Bold the names of toolbars. 

 

 
On the toolbar, click the Back button. The last element selected displays. 
On the toolbar, click the Find button. The Find dialog opens. 
On the toolbar, right-click anywhere in the Filter section and select Critical/Major/Minor. Other 
filter states dim. 

Elements and 
Alarms 

Use “Select” when instructing users to click on an element or alarm. Do not instruct users to “click 
on” an element or alarm.  
Bold the names of elements and alarms. 
Click to select the alarm(s). 
Click to select the element(s). 
From a list:  Click to select Administration. 

Sections A section is part of a pane or dialog. Use the preposition “in” when specifying a section. 
Bold the names of sections. 
In the Filter section of the toolbar, click to select the Filter button(s) to remove the associated 
alarms from the view. The selected Filter buttons dim. 

Buttons and Icons  
Standards for Referring to Command Buttons and Mini-buttons 

Component or 
Location 

Terminology/Examples 

Command Buttons Command buttons generally include the name of the button on the button as follows: 

     
When referring to a command button, state the name of the button. Do not include a graphic of 
command buttons within the text. Bold the names of buttons. 
To continuously update alarms, click the Resume button. 
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Standards for Referring to Command Buttons and Mini-buttons 

Component or 
Location 

Terminology/Examples 

Toolbar Buttons Toolbar buttons are generally a set of buttons that do not include the names of the buttons. 
Examples of mini-buttons include filter buttons toolbar buttons in the RSE product as follows: 

 
Refer to mini-buttons as buttons. Do not include a graphic of the mini-button. Bold the names of 
mini-buttons. 
Click the appropriate Filter button. 

Icons Icons include graphical depictions of the button’s purpose.  

 
When referring to an icon, state the name of the icon and include the graphic of the button just 
before the icon’s name. Bold the names of icons. 

On the Rules Hierarchy toolbar, click  Delete. A confirmation box opens to confirm the 
deletion. 

Referring to Screen and Dialog Components 
The following table lists the components of dialog and screens and describes 
how to refer to each component. 

Screen and Dialog Components 
Component Example/Terminology 
Text box Use “Type” when instructing the user to enter data in a text box.  

Bold the names of text boxes. 

 
(create profile) Type a profile name in the Name text box. 
(create calendar) Type a calendar name in the Name text box. 

Drop-down List For drop-down lists, use “Click” and “select”.  
Bold the names of drop-down lists. 

 

 
(specific) Click the Layout Presets drop-down list and select Circles. 
(general) Click the Layout Presets drop-down list and select a preset type. 

Radio Button For radio buttons, use “Click to select”.  
Bold the names of radio buttons. 

 
Click to select the Use Interval radio button. 
Click to clear the Use Interval radio button. 

Hypertext Links For hypertext links, use “Click the XXX link”.  
Refer to hypertext links as “links”. 
Bold the names of links. 

 
 

Click the Add new action link. 
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Screen and Dialog Components 
Component Example/Terminology 
Check box For check boxes, use “Click to select”.  

Bold the names of check boxes. 

 
Click to select the Set radius automatically check box. 
Click to clear the Set radius automatically check box. 
 

 

 
 
In the Restrict Usage section, select one or both options required to restrict access to the 
Formula Client or Portal tools.   

î Formula Client – prevents access to the Formula browser. 

î Business Service Dashboard – prevents access to PortalBuilder webpage 
and the Formula Portal Component Toolkit. 

Slider Bar For slider bars, use “move to adjust”.  
Bold the names of slider bars. 

 
Move the Minimum Node Spacing slider to adjust the smallest acceptable spacing between 
element siblings. 

Command Button Use the name of the button and refer to it as a button. 

 
Click the OK button. 

List box Refer to a list box as a “list”. Use the preposition  “from” when directing a user to a list box.  

 
1. To add the user to all groups, click the Add All>> button. All users and groups from 

the Not member of list display in the Member of list. 

2. To selectively add the user to a group(s), click to select the user group(s) from the 
Not member of list. Click the Add> button. The user group(s) displays in the 
Members of list. 
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Screen and Dialog Components 
Component Example/Terminology 
Property  
Table 

When referring to property tables, use “In the XX section”.  
Bold the names of properties. 

 
1. In the Properties section, specify required adapter information. For more 

information, see adapter properties. 

2. Click the Create button. The adapter is created. 

Spinners When instructing users about a spinner, state the purpose of the spinner as opposed to 
instructing users to select the up or down arrow. 

 
Use the Start Time spinner to select the starting time. 

Miscellaneous Items in Step-by-step Instructions 
Standards for Referring to Miscellaneous Items 

Component or 
Location 

Terminology/Examples 

Command Line Use “Type” when instructing the user to issue a command from the command line.  For example, 
Type the command, mosdaemon formula at the command line prompt.   

Toggling For menu commands that toggle on and off, use “select or deselect” to indicate that users click on 
the menu command to do both. For example, 
In the Explorer pane, right-click the background and click to select or deselect Show  
Condition Indicators. When selected, condition indicators display. 

Dialog Components 
Use the dialog component name listed on the user interface to refer to the dialog 
components identified in the following illustration.  
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Dialog Components 

Formula Browser Components 
The following graphic depicts the Formula Browser components. 

Toolbar Root Element Status Bar Filter Buttons Explorer Pane View Pane View Tabs Text Box Check Box Button Radio Button Drop-down List Scroll Bar Section List Box 
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Formula Browser Components 

Wizards 
When describing the use of a wizard, refer to it as a wizard the first time and refer 
to the series of screens that display as part of wizard as dialogs. For example: 

1. Click the Add Organization button. The Add Organization wizard opens. 

2. Select the element to be added and click the Forward button. The Browse 
for Element dialog opens. 

Index 
Managed Objects technical documents contain an index that follows the following 
conventions: 

§ Use lowercase except for where capitalization is required. 
§ Do not repeat the main term in subentry. 
§ Limit the use of prepositions and articles. Use them only when they are 

necessary for clarity or sense. (i.e. reading from, writing to) 
§ Use a gerund rather than the infinitive or the present tense form for actions, 

processes, or procedures. (i.e. selecting, drawing, acknowledging) 
§ Use only one level of subentries. 
§ Use the plural form of all main entries that are nouns, except where awkward 

or illogical to do so. (i.e. files, headers, alarms)  (i.e. e-mail, File command) 
§ Look specifically at the following for potential keywords when developing the 

index: 
§ Headings 
§ Terms and concepts important to the user 
§ Overviews 
§ Procedures and user actions 
§ Acronyms 

Menus 
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§ Definitions or new terms 
§ Commands, functions, methods, and properties 

The Index requires the following unique formatting: 

§ Insert a section break after the last line of the previous chapter to allow the 
footer to be modified from the footer used in the body of the document. 

§ Remove the word “Chapter” and the field inserted to refer to the Chapter 
number from the footer.  

 
  



Chapter 5 - Document Content  34  

5 
Document Content 

Several sections are standardized in all Formula technical documents. This 
chapter presents the sections that are standardized within each Managed 
Objects technical document. 

This chapter contains the following topics: 

Copyright Text 
Introduction Page Content 
Introduction 
Using This Guide 
Related Documentation 
Viewing Formula Documentation 
Getting Help 
Documentation Conventions 
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Copyright Text 
Copyright text appears immediately after the cover page. You need to update the 
version number of the document, which is indicated below. 

COPYRIGHT 

Copyright © 1997-2006 Managed Object Solutions, Inc. All rights reserved. This 
documentation and the software described in it are furnished under license and may be 
used only in accordance with the terms of such license. The information in this 
documentation is provided for informational use only and is subject to change without 
notice. Managed Object Solutions, Inc. shall not be liable for any errors or inaccuracies 
that may appear in this documentation. Except as permitted by the license for this 
documentation or with the prior written consent of Managed Object Solutions, Inc., no part 
of this documentation may be reproduced, stored in a retrieval system, or transmitted, in 
any form or by any means, electronic, mechanical, recording or otherwise. 

TRADEMARKS AND PATENTS 

Managed Objects™, the Managed Objects logo, Formula®, the Formula logo, Formula 
Engine™, FormulaScript™, Managed Objects Definition Language 
(MODL)™,     Business Data Integrator™, Business Experience Manager™, Business 
Service Console™, Business Service Configuration Manager™, Business Service Object 
Model™, Business Service Dashboard™, Business Service Level Manager™, Business 
Service Level Manager Engine™, Business Service Views™, Business Service 
Warehouse™, Business Technology Insight™, Data Warehouse Engine™, Event 
Integrator™, Event Integrator Ruleset Editor™, PortalBuilder™, Portal Component 
Toolkit™, virtual Configuration Management Database™, vCMDB™ are trademarks of 
Managed Object Solutions, Inc. 

DOS, Microsoft, Windows, Windows XP and Windows NT are registered trademarks of 
Microsoft Corporation. IBM is a registered trademark of International Business Machines 
Corporation. 

All other marks and product names are trademarks or registered trademarks of their 
respective holders. 

 

 

 

 

 

Revision: v4 System Administration Guide (04/05) 

 

Managed Object Solutions, Inc. 

7925 Westpark Drive 

McLean, VA  22102 

703.208.3330  

support@managedobjects.com 

http://www.managedobjects.com 

 

Update the copyright 
year here. 

Update the title of the 
document and the 
month and year of 
publication here. 
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Introduction Page Content 
Each Managed Objects technical document begins with an Introduction page that 
is Chapter 1. The Introduction page contains a paragraph that describes the 
intended users for the document and a brief overview of the document’s 
contents. The following section, Introduction, can be copied and pasted into any 
Managed Objects technical document. 

Introduction 
Managed Objects software translates complex technology into business terms, 
enabling you to understand how your infrastructure impacts your business. Built 
with the latest generation of Internet technologies, it dynamically integrates and 
consolidates data from your existing management systems. From this single 
point of control, Business Service Views depict the relationship between IT 
resources and the services they support across management systems, business 
processes, and even across companies. 

Managed Objects software also provides bi-directional access to the full 
functionality of your underlying management systems. This enables you to 
manage all your IT resources as a seamless, real-time representation of your 
business. This centralized view and control allows you to improve service across 
the board. 

Using This Guide 
Some Managed Objects technical documents contain a Using This Guide 
section that outlines how the content of the document can be used to accomplish 
specific tasks. It can also discuss how the content of the document relate to the 
content of other Managed Objects technical documents.  

Related Documentation 
The following tables list the documents available. 

Getting Started Guides 
Document Description 
Primer  Provides an overview and guidelines for implementing a solution that includes 

definitions for key terms and components and examples that illustrate server 
configurations 

User's Guide Provides instructions for using various management capabilities including basic 
browser features, creating drawings for Business Service Views, navigating element 
relationships and identifying objects affected by condition changes 

Installation Guide Provides instructions for installing and launching Managed Objects software and 
Object Request Brokers (ORBs) for supported management systems 

Release Notes Describes new features and changes in the release 
 
Administration Guides 

Document Description 
Administrator’s Guide Describes how to configure the browser, define organizations, create users and groups 

and define their access privileges to various elements, set up automation events, 
frequently used administrative utilities, and other administrative tasks  

Script Guide Provides instructions for using FormulaScript to customize enterprise management 
capabilities to more efficiently manage the elements in a managed environment 



Chapter 5 - Document Content  37  

Administration Guides 
Document Description 
Business Service Warehouse 
Data Dictionary 

Provides lists and descriptions of Business Service Level Manager™ (BSLM) 
performance database tables, alarm tables, and warehouse database tables 

 
Application and Management Tool Guides 

Document Description 
Business Data Integrator™ 
(BDI) Guide 

Provides instructions to extract business metrics from databases and analytics from 
business intelligence tools for correlation, analysis and visualization using Business 
Service Views and Business Service Dashboards 

Business Experience 
Manager™ (BEM) Guide 

Provides instructions for collecting application and performance metrics from a wide 
variety of sources, managing response time, synthetic testing and application 
performance from a single application, and identifying and prioritizing sources of 
performance problems 

Business Service 
Configuration Manager™ 
(BSCM) Guide 

Provides instructions for using the Business Service Configuration Manager to obtain 
visibility into a network to manage the lifecycle of services and includes information 
about how to correlate network objects, create a virtual CMDB, map dependencies into 
views, and automatically adapt to changes and identify services that are under 
managed 

Business Service 
Dashboard™ (BSD) Guide 

Provides instructions for building custom portals and dashboards using the 
PortalBuilder™ or JSP programming to leverage the JavaServer Pages (JSP) tag 
libraries and the Portal Component Toolkit™ 

Business Service Level 
Manager (BSLM) Guide 

Describes how to use the Business Service Level Manager to define service level 
agreements and objectives and to monitor, manage and report service level health and 
compliance in real-time and historically 

Business Technology Insight 
Guide 

Provides instructions for discovering and monitoring application components, 
dependencies, and utilization in your network 

Event Integrator™ Guide Provides instructions for processing alarm and other data derived from different 
sources through the Event Integrator and creating and managing rulesets using the 
Event Integrator Ruleset Editor 

SNMP Integrator Guide Provides instructions for using the SNMP adapter to poll, and obtaining and viewing 
data available about SNMP agents 

 
Integration Guide 

Document Description 
Adapter and Integration 
Guide 

Provides instructions for creating and configuring adapters to integrate with different 
management systems, representing data from multiple sources such as log files and 
databases as events and integrating with discovery tools and trouble ticket systems 

 
Support Guide 

Document Description 
Customer Support Guide Describes the support infrastructure at Managed Objects, the areas covered by 

Support, the process for interacting with Support, and the guidelines and objectives 
that Managed Objects maintains for Customer Support 

Viewing User Documentation 
From the Formula home page, you can view all Formula user documents in an 
Adobe Acrobat PDF format. To download a PDF reader, go to 
http://www.adobe.com/. 

To view Formula documentation from the Web browser: 

1. From the Managed Objects Login page, click the Documentation link. The 
Documentation Web page opens. 

 
Formula delivers its 
product 
documentation as 
.pdf documents that 
are available from the 
Start >Programs> 
Managed Objects> 
Documentation 
menu. In addition, 
several online user 
guides and online 
Administrator and 
Client Help functions 
are provided. 
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2. Double-click the Formula documentation link for the document you want to 
access. The document opens in a PDF reader or Web browser.  

To view Formula documentation from the desktop application: 

1. From the desktop, click Start, Programs, Managed Objects, and select 
Documentation. The Documentation Web page opens. 

2. Click the link for the document you want to access. The selected document 
opens in a PDF reader or Web browser. 

Accessing Online Help 
Formula online help includes administrator and end user topics. A keyword 
search feature is available to help locate a specific topic. 

To access online help: 

î From the Managed Objects browser, click the Help link and select Open 
Online Help. 

Documentation Conventions 
The following documentation conventions are used throughout Managed Objects 
technical documentation. 

Document Conventions 
Convention Description 
Bold File names, path names, user interface elements, and URLs are presented in Bold. 
Plain Italics Reference sources or other documents referenced in this guide are italicized. 
Bold Italics Information you supply is presented in bold italics. 
Courier with grey shading Programming code examples are shown in plain courier or 

courier with grey shading. Courier Bold is used for emphasis. 

Mouse Instructions § “Click” refers to a single click of the left mouse button.  
§ “Double-click” refers to two quick clicks of the left mouse button.  
§ “Right-click” refers to one click of the right mouse button.  
§ “Drag” refers to holding down the left mouse button while moving the mouse. 
§ ”Select” refers to clicking an option. 

blue underlined text Hyperlinks are presented in blue underlined text 
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6 
Preparing Documents for Publication 

Before Managed Objects technical documents are released for publication and 
distribution, they are reviewed for quality and converted to .pdf file format. This 
chapter describes the quality assurance process for technical documentation.   

This chapter contains the following topics: 

Quality Assurance Process - Technical Documents 
Quality Assurance Process - Release Notes 
PDF Generation 
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Quality Assurance Process - Technical Documents 
Prior to generating the .pdf version of a document, review the format and content 
for compliance with the Writer’s Guide. The following table lists items and 
information that are reviewed for quality and can be used as a checklist to 
document the quality review of technical documents. 

Release Notes Quality Assurance 
Section Description  Yes No 
Title Page § Title cored 

§ Version number correct 
  

Copyright Page § Copyright year updated to current year 
§ Revision number and month/year of publication correct 

  

Table of 
Contents 

§ Table of Contents generated prior to publication 
§ Chapter numbers correct 
§ Chapter numbers removed from Index and Appendices 

  

Page Layout § Page numbers begin with 1 on the first page of Chapter 1 
§ Page numbers sequential throughout document 
§ Setting in compliance with Page Setup Requirements 

  

Chapter Pages § Each chapter’s first page contains list of Heading 2 topics as hyperlinks 
§ Page break inserted at the end of the first page of each chapter 

  

Content § Ariel text used throughout document 
§ Instructions are numbered sequentially begin with 1for the first stop of each 

list in compliance with Step-by-Step Instructions 
§ All highlighting and track changes notations removed 
§ Spell check has been run 
§ All tables have a title in a cell at the top of the table except for tables in 

step-by-step instructions in compliance with Tables 
§ All figures have a caption except for figures in step-by-step instructions in 

compliance with Illustrations and Captions 
§ All bulleted lists use the correct bullet style in compliance with Bulleted Lists 

  

Index § Index has been run   

Footers § Footers begin with page 1, which is the first page of Chapter 1 
§ Footers in compliance with Page Footers 

  

Quality Assurance Process - Release Notes 
Release Notes summarize the changes in the product for each release. Changes 
can include Enhancements or Resolved Issues. Enhancements are 
improvements in the product that are applicable to all or a broad range of 
customers. Resolved Issues are changes in response to a specific issue 
identified by a customer or internally.  

When possible, classify changes as Enhancement including changes initiated in 
response to an issue or problem. The following procedure describes the process 
used to evaluate and summarize product changes as either an Enhancement or 
Resolved Issue.  

To Review all Change Requests (CRs) to classify each as either an 
Enhancement or Resolved Issue: 
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1. Review each CR title to determine if it includes a Support Request (SR) 
number. 

2. For CRs that include and SR number and no Customer is specified, rewrite 
the change as an Enhancement, if possible. 

3. For CRs that do not do not include an SR number and a Customer is 
specified, perform one of the following steps: 
î Review the Attachment links to determine if the CR is linked to a SR 

and review the related SR to determine if the change can be written up 
as an Enhancement. 

î Review the Attachment links to determine if a Managed Objects 
employee, which is indicated by Internal MO, initiated the CR and 
classify the change as an Enhancement unless the change was minor 
and does not need to be included in the Release Notes. 

4. After classifying each CR as an Enhancement, Resolved Issue, or issue so 
minor that it does not need to be included in the Release Notes, group 
related CRs by product. Use product area in front of the short description 
when there are multiple CRs for a product/product area. Subcategorize 
issues under a product if multiple issues exist or it is deemed appropriate. 
Where possible, combine items that are similar. 

5. Organize and combine similar items within the lists of Enhancements and 
Resolved Issues. 

6. Format each item using the following format conventions: 

î Short description. (CR# XXXXX / SR# XXXXX) 

î Short description. (CR# XXXXX, XXXXX / SR# XXXXX, XXXXX) 

î Product Area: Short Description. (CR# XXXXX / SR# XXXXX) 

Copies for the QA Department 
Because PDF generation is time consuming and guides change often up until the 
final build for a release, we make every attempt to limit the number of times that 
PDF files are generated. To facilitate general QA efforts without requiring PDF 
generation, be sure to copy a version of the Word docs into the 
gwynn/source/docs for Eddie directory on a regular basis or after major 
updates to the docs. 

PDF Generation 
All Managed Objects technical documentation is delivered to customers as a .pdf 
file on a CD.  

To generate a .pdf: 

1. Scroll through the file to ensure that the file was properly generated. 

2.  Collapse the bookmarks. 

3. Set the file so that the bookmarks tab is open when the pdf document is 
opened  
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7 
Online Help 

The online help system is generated using RoboHelp. This chapter provides an 
overview of required steps and useful information when generating Managed 
Objects online help. 

This chapter covers the following topics: 

RoboHelp 
Online Help Topics 
Project Source Files 
Files, Formatting & Customizations 
Verification Steps 
Online Help Generation 
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RoboHelp 
The Managed Objects help system is a web-based help system implemented by 
using RoboHelp X5.  The following are external resources that may be of help 
when developing in RoboHelp: 

§ http://www.grainge.org/ 
§ http://www.macromedia.com/cfusion/webforums/forum/index.cfm?NoCookies

=Yes 
§ http://www.macromedia.com/support/robohelp/htmlhelp.html 
§ http://www.helpdevelopment.com/webhelp/creating_a_webhelp_3_glossary.h

tm 

Online Help Topics 
Currently, the online help is divided into the following main topics: 

§ General Topics (topics from the user guide) 
§ Administration (topics from the admin guide) 
§ Event Integrator (topics from the Eve guide) 
§ Service Level Agreements (topics from the BSLM guide) 
§ Business Service Dashboards (portalbuilder portlets (edit-side options)) 

Topics Unique to the Online Help System 
The following topics are unique to the online help system. In other words, they 
are no longer covered in the user guides, but only in online help: 

§ PortalBuilder Portlets – edit-side options for each portlet. 
§ Relationship Browser – option descriptions for the Manage Layout Presets 

and Element Layout Properties dialogs. 

Project Source Files 
The RoboHelp project (source files) can be checked out using Subversion from 
the MOS_Help/onlineHelp/src directory. 

To update the online help and check into the product: 

1. Update the help using RoboHelp and generate the output. 

2. Create a language specific folder directly under one of your local drives and 
direct the RoboHelp output to that directory. (e.g. d:/en for English). 

3. Create a zip of the folder (e.g. en.zip) 
î It is important to select the option to retain directory information (i.e. 

en/…) 

4. Check in the zip file(s) into SVN in the MOS_Help/onlineHelp directory. 

Hooks from Managed Objects Software 
The links that the product uses to access the online help system are in the 
MOS_Help/onlineHelp/xml/helpcontent.xml file. All URLs need to be 
lowercase to match the generated help files from RoboHelp. 
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Files, Formatting & Customizations 
Topic Files & File Extensions 
Topic files use the following standards: 

§ All files use the .html extension.  When creating a new topic please be sure 
to use the .html extension. 

§ Filenames should be lower case.  This is best if the online help is being used 
in a UNIX environment. 

Stylesheet 
All files use the xxx.css stylesheet file.  When creating a new topic please be 
sure to attach the styesheet to the topic file. 

Templates 
The Templates/MO Template.htt file provides style guidelines and various 
elements that can be copied and pasted into a topic file: 

§ 2 and 3 column Tables 
§ Notes 

Removing the RoboHelp Logo 
It is necessary to perform this procedure from any machine where the online help 
system is generated from. 

To remove the RoboHelp logo from your RoboHelp projects: 

1. Locate your webhelp template_skin directory. Mine was at C:\Program 
Files\RoboHelp Office\RoboHTML\WebHelp5Ext\template_skin.  

2. Find the whtbar.js file and make a backup copy somewhere.  

3. Open whtbar.js with Notepad. 

4. Find the code block in the addButton function (not addBanner) that starts 
with else if(sType=="banner") 
î This appears at the end of the addButton function and just before the 

isShowHideEnable function on my system. 

5. Comment out the line in that block that reads 

î addBanner(sI1); 

6. To comment out the line just type // at the start of the line. This prevents the 
addBanner function from running, but leaves everything else intact. 

7. If running RoboHelp, you'll need to exit and restart the program for the 
changes to take effect. 

It doesn't remove the logo from existing projects but you'll never see it in a new 
one unless you reverse the procedure. 

Verification Steps 
The following things need to be performed routinely before the final build for a 
product release. 

§ Check for and resolve any broken links 
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Online Help Generation 
Keeping RoboHelp files current is a multi-step process. Generate the output, zip 
it up then check it into subversion along with RoboHelp project files that have 
changed. 

To generate the online help output: 

1. Click File and select Generate Primary Output (should be WebHelp). 

2. If there is an option to convert all files to lowercase, select it. 

3. Make sure output directory is en and the start page is 
Managed_Objects_Online_Help.html. 

4. Select the DHTML > Java Applet > Pure HTML radio button. 

5. Select the Optimize Speed for: Local PC or Intranet radio button. 

6. Zip all the files in the en directory using the Save extra folder info option (or 
one that saves folder structure info. Check in the source and zip file to 
subversion. See Project Source Files. 
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Appendix A - Index 

 

Attaching a Template to a Document, 7 
Bulleted Lists, 19 
Buttons 

command buttons, 27 
mini-buttons, 27 

Capitalization Conventions, 17 
Chapter Numbers, 13 
Code Samples, 21 
Dialog Components, 30 
Documentation Archive, 2 
Documentation Conventions, 37 
Examples of Navigation Text, 25 
Formula 

support, 36 
Formula Browser Components, 30 
General Writing Requirements, 16 
Help, 37 
Icons, 27 
Illustrations and Captions, 20 
Index, 31 
Layout, 11 

Margins, 11 
Navigation Text for Step-by-Step 

Instructions, 24 
Notes and Gutter Notes, 18 
Page Footers, 13 
Page Setup, 11 
Referring to Screen and Dialog 

Components, 27 
Related Documentation, 35 
Restricted Clients, 28 
Screen and Dialog Components, 27 
Standard Terms for Step-by-step 

Instructions, 25 
Standard Vocabulary, 3, 16 
Step-by-Step Instructions, 22 
Table of Contents, 14 
Tables, 19 
Template Styles, 5 
Using the Portal View, 24 
Viewing Formula Documentation, 37 

 
 


